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BAB I  

PENDAHULUAN 

 

A. Latar Belakang 

Remaja pada dasarnya merupakan masa peralihan dari kanak-kanak menuju 

dewasa, menurut Y. Singgih D. Gunarso (1998 : 8) bahwa masa remaja adalah 

permulaannya ditandai oleh perubahan-perubahan fisik yang mendahului  

kematangan seksual. Kurang lebih bersamaan dengan perubahan fisik ini, juga akan 

dimulai proses perkembangan psikis remaja pada waktu mereka melepaskan diri 

dari ikatan orang tuanya, kemudian terlihat perubahan-perubahan kepribadian yang 

terwujud dalam cara hidup untuk menyesuaikan diri dalam masyarakat. 

 Remaja Pada perkembangannya seringkali rentan mengalami masalah karena 

remaja sedang mencari jatidirinya. Permasalahan tersebut terjadi pula pada remaja 

yang tinggal di pondok pesantren dimana permasalahan yang paling mendominasi 

yakni masalah penyesuaian diri. Penyesuaian diri menurut Schneiders dalam 

(Desmita, 2009:192) yakni suatu proses yang mencakup respon mental dan tingkah 

laku, dimana individu berusaha untuk dapat berhasil mengatasi kebutuhan-

kebutuhan dalam dirinya, ketegangan-ketegangan, konflik-konflik, dan frustrasi 

yang dialaminya, sehingga terwujud tingkat keselarasan atau harmoni antara 

tuntutan dari dalam diri dengan apa yang diharapkan oleh lingkungan dimana ia 

tinggal.  
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Adapun Fenomena yang terjadi yang dihadapi oleh remaja di pondok pesantren 

pada masalah peralihan tempat tinggal yakni dari yang tinggal di rumah bersama 

keluarga lalu masuk ke sebuah psantren. Proses peralihan ini meliputi bagaimana 

cara remaja bergaul, bersikap serta berinteraksi dengan teman-teman dan pengasuh, 

dalam hal ini remaja dituntut untuk dapat menyesuaikan diri dengan suasana di 

pondok psantren misalnya dapat mentaati segala peraturan yang diterapkan di 

pondok psantren, yang tentunya berbeda dengan peraturan saat tinggal dirumah 

bersama keluarga. 

 Lingkungan menjadi lingkungan sosial yang utama dalam mengadakan 

penyesuaian diri. Keberadaannya di pondok pesantren membuat mereka mampu 

belajar mendapatkan pengalaman bersosialisasi pertama kalinya baik dengan 

teman-teman dan pembimbing di pondok psantren. Remaja dituntut dapat 

berkembang dan menyesuaikan diri agar menjadi modal utama mereka ketika 

berada dalam masyarakat luas. Apabila remaja tidak dapat menyesuaikan diri 

dengan lingkungannya, maka remaja akan memiliki sikap negatif dan tidak dapat 

menyesuaikan diri dengan lingkungannya. 

Yayasan Al- Kasyaf sendiri merupakan sebuah lembaga pendidikan non formal 

dan kegiatan sosial yang menyantuni kalangan tidak mampu dan anak yatim yang 

berdiri sejak tahun 2013, Pondok Pesantren Yatim dan Duafa Al-Kasyaf ini 

membantu anak-anak dengan latar belakang yang berbeda-beda seperti anak yang 

tidak mempunyai orangtua (yatim piatu), anak yang berasal dari keluarga yang 

tidak mampu, anak korban perceraian, juga anak yang terlantar yang ditinggalkan 

oleh orangtuanya, selain pendidikan keagamaan, pendidikan formal anak-anak 
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tetap tidak dilupakan, semua anak didik di panti asuhan tetap disekolahkan di 

sekolah formal hingga tingkat SMA. Mayoritas anak di Pondok Pesantren Yatim 

dan Duafa Al-Kasyaf terdiri dari anak-anak remaja usia sekolah SMP–SMA. 

(Observasi, Pondok Pesantren Yatim dan Duafa Al-Kasyaf, 02/02/2018) 

Berdasarkan hasil wawancara yang di lakukan di Pondok Pesantren Yatim dan 

Duafa Al-Kasyaf , ada beberapa aspek  permasalahan dalam penyesuaian diri yang 

terdapat pada anak-anak remajanya yaitu pada masalah pribadi nya masih ada 

beberapa remaja yang merasa kurang percaya diri, minder, kurangnya motivasi 

belajar, lalu dalam interaksi sosial nya ada sebagian remaja yang hanya ingin 

berteman dengan satu teman atau dengan teman satu kampungnya sehingga sulit 

untuk berbaur dengan yang lainnya. (wawancara Bapak Asep Wahyudin, S.E, 

02/02/2018) 

Untuk menanggulangi permasalahan tersebut salah satu upaya yang dilakukan 

yaitu dengan diadakannya bimbingan pribadi-sosial terhadap remaja dengan tujuan 

agar remaja dapat mengatasi masalah pribadinya juga permasalahan sosialnya. 

Masalah-masalah yang menarik dan penting dalam bimbingan pribadi sosial 

tersebut meliputi bagaimana kondisi sebenarnya dari pribadi dan sosial remaja di 

panti asuhan, bagaimana proses bimbingan dengan segala unsur yang terlibat di 

dalamnya dan bagaimana pengaruh bimbingan pribadi-sosial terhadap penyesuaian 

remaja di Pondok Pesantren Yatim dan Duafa Al-Kasyaf.  

Sehingga dirumuskan dalam penelitian yang berjudul “ PENGARUH 

BIMBINGAN PRIBADI-SOSIAL TERHADAP PENYESUAIAN DIRI REMAJA 
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(Penelitian di Pondok Pesantren Yatim dan Du’afa Al-Kasyaf Cipadung-Cibiru 

Kota Bandung)” 

B. Rumusan Masalah 

1. Bagaimana Kondisi Penyesuaian Diri Remaja Di Pondok Pesantren Yatim 

dan Du’afa Al-Kasyaf? 

2. Bagaimana Proses Bimbingan Pribadi-Sosial Di Pondok Pesantren Yatim 

dan Du’afa Al-Kasyaf? 

3. Bagaimana Pengaruh Bimbingan Pribadi-Sosial Terhadap Penyesuaian Diri 

Remaja Di Pondok Pesantren Yatim dan Du’afa Al-Kasyaf? 

C. Tujuan Penelitian 

1. Untuk Mengetahui Kondisi Penyesuaian Diri Remaja Di Pondok Pesantren 

Yatim dan Du’afa Al-Kasyaf? 

2. Untuk Mengetahui Proses Bimbingan Pribadi-Sosial Di Pondok Pesantren 

Yatim dan Du’afa Al-Kasyaf? 

3. Untuk Mengetahui Pengaruh Bimbingan Pribadi Sosial Di Pondok 

Pesantren Yatim dan Du’afa Al-Kasyaf? 

D. Kegunaan Penelitian 

1. Secara Teoritis  

Penelitian ini di harapkan mampu memberikan sumbangan 

keilmuan dan pengetahuan yang berhubungan dengan keilmuan bimbingan 

dan konseling islam. 
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2. Secara praktis 

Penelitian ini diharapkan dapat memberikan kontribusi yang positif 

bagi pelaksanaan bimbingan dan konseling di Pondok Pesantren Yatim dan 

Du’afa Al-Kasyaf. 

E. Kerangka Pemikiran 

Bimbingan secara etimologi merupakan terjemahan dari bahasa inggris 

yaitu ‘guidance” yang artinya bantuan atau tuntunan. Menurut Rochman 

Natawidjaja dalam ( Chodijah, 2016;15) mengartikan bimbingan sebagai suatu 

proses pemberian bantuan kepada individu yang dilakukan secara 

berkesinambungan, supaya individu tersebut dapat memahami dirinya, 

sehingga ia sanggup mengarahkan dirinya dan dapat bertindak secara wajar, 

sesuai dengan tuntutan dan keadaan lingkungan sekolah, keluarga masyarakat 

dan kehidupan pada umum nya. Dengan demikian ia akan dapat menikmati 

kebahagiaan hidupnya, dan dapat memberikan sumbangan yang berarti kepada 

kehidupan masyarakat pada umumnya. Bimbingan membantu individu 

mencapai perkembagan diri secara optimal sebagai mahluk sosial.  

Menurut Prayitno (2004:99) dalam kutipan Lilis Satriah, bimbingan adalah  

bantuan yang diberikan oleh orang ahli, kepada seseorang atau beberapa 

individu, baik anak-anak, remaja maupun dewasa. Tujuannya yaitu agar yang 

di bimbing dapat megembangkan kemampuannya dengan memanfaatkan 

kekuatannya sendiri, dan sarana yang ada. 

Sedangkan bimbingan pribadi sosial menurut Abu Ahmadi (1991;109) 

yakni seperangkat bantuan kepada peserta didik agar dapat menghadapi sendiri 
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masalah-masalah pribadi dan sosial yang di alaminya, mengadakan 

penyesuaian pribadi dan sosial, memilih kelompok sosial, memilih jenis jenis 

kegiatan sosial dan  rekreatif yang bernilai guna serta berdaya upaya sendiri 

dalam memecahkan masalah-masalah pribadi, rekreasi dan sosial yang 

dialaminya. Menurut Syamsu Yusuf (2005;11) yang mengungkapkan bahwa 

bimbingan pribadi-sosial adalah bimbingan untuk membantu para individu 

dalam memecahkan masalah-masalah sosial-pribadi. 

Jadi dapat di simpulkan bahwa bimbingan pribadi sosial yakni seperangkat 

bantuan terhadap remaja di Pondok Pesantren Yatim dan Du’afa Al-Kasyaf 

untuk dapat menyelesaikan permasalahan pribadi maupun sosialnya. 

Bimbingan pribadi sosial dilakukan dengan cara menciptakan lingkungan yang 

kondusif, menciptakan lingkungan sosial yang akrab, mengembangkan sistem-

sistem pemahaman diri dan sikap-sikap yang positif, serta mengembangkan 

kemampuan pribadi sosial yang baik.  

Adapun Aspek-aspek bimbingan pribadi-sosial dalam tugas 

perkembangannya yaitu membantu klien agar memiliki kesadaran diri, 

dapat mengembangkan sikap positif, membuat pilihan secara sehat, mampu 

menghargai oranglain, memiliki rasa tanggung jawab, mengembangkan 

keterampilan hubungan antar pribadi, dapat menyelesaikan konflik, dapat 

membuat keputusan secara efektif. 

Penyesuaian diri adalah usaha manusia untuk mencapai harmoni 

pada diri sendiri dan pada lingkungannya. Sehingga rasa permusuhan, 

dengki, iri hati, pransangka, depresi, kemarahan, dan lain-lain emosi negatif 
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sebagai respon pribadi yang tidak sesuai dan kurang efisien bisa dikikis 

habis (Kartini Kartono, 2002:56). Penyesuaian diri adalah suatu proses yang 

mencakup respon mental dan tingkah laku, dimana individu berusaha untuk 

dapat berhasil mengatasi kebutuhan-kebutuhan dalam dirinya, ketegangan-

ketegangan, konflik-konflik, dan frustrasi yang dialaminya, sehingga 

terwujud tingkat keselarasan atau harmoni antara tuntutan dari dalam diri 

dengan apa yang diharapkan oleh lingkungan dimana ia tinggal (Schneiders 

dalam Desmita, 2009:192).  

Ada beberapa aspek yang terdapat dalam penyesuaian diri menurut  

(Zainun, 2002:6) yakni: Aspek afektif emosional, Aspek perkembangan 

intelektual atau kognitif, Aspek perkembangan sosial. 

Adapun Karakteristik Penyesuaian Diri Menurut Enung dalam 

(Nofiana, 2010:17) antara lain : Tidak menunjukkan adanya ketegangan 

emosional yang berlebihan. Tidak menunjukkan adanya mekanisme 

pertahanan diri yang salah. Tidak menunjukkan adanya frustasi pribadi. 

Memiliki pertimbangan yang rasional. Mampu belajar dari pengalaman. 

Bersikap realistik dan objektif.  

Remaja merupakan masa transisi dari anak-anak menuju dewasa, 

dimana dalam masa ini remaja rentan mengalami masalah. Beberapa ahli 

mengemukakan pengertian remaja sebagai berikut; Menurut Hurlock 

(1999) dikatakan sebagai masa transisi, sebagai periode peralihan, sebagai 

periode perubahan, sebagai usia bermasalah, sebagai masa mencari 

identitas, sebagai usia yang menimbulkan ketakutan, sebagai masa yang 
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tidak realistic dan sebagai ambang masa dewasa, karena belum mempunyai 

pegangan, sementara kepribadianya masih mengalami suatu perkembangan, 

remaja masih belum mampu untuk menguasai fungsi-fungsi fisiknya. 

Remaja masih labil dan mudah terpengaruh oleh lingkungan sekitarnya, 

sehingga di peroleh suatu gambaran yang jelas tentang dirinya dan supaya 

remaja bisa menjalankan apa yang sudah didapatkannya.  

Sedangkan Menurut Santrock (2007) remaja (adolescence) diartikan 

sebagai masa perkembangan transisi antara masa anak dan masa dewasa 

yang mencakup perubahan biologis, kognitif dan sosial emosional. Ia 

melanjutkan masa remaja awal (early adolescence) kira-kira sama dengan 

masa sekolah menengah pertama dan mencakup kebanyakan perubahan 

pubertas.  

Berdasarkan pemaparan di atas  bimbingan pribadi-sosial diharapkan dapat 

membantu proses penyesuaian diri pada remaja di panti asuhan, bimbingan 

pribadi-sosial ini bertujuan agar remaja dapat mengembangkan potensi pribadi dan 

bersosialisasi dengan lingkungannya secara baik seperti yang di katakan oleh 

Dewa Ketut Sukardi (1993;19) bahwa bimbingan pribadi sosial merupakan usaha 

bimbingan, dalam menghadapi masalah pribadi-sosial seperti penyesuaian diri, 

menghadapi konflik dan pergaulan. 

F. Hipotesis 

Hipotesis Penelitian ini ialah : 

H0 = Tidak Ada Pengaruh Bimbingan Pribadi Sosial Terhadap Penyesuaian Diri 

   Remaja Di Pondok Pesantren Yatim dan Du’afa Al-Kasyaf. 
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H1 = Ada Pengaruh Bimbingan Pribadi Sosial Terhadap Penyesuaian Diri  

   Remaja Di Pondok Pesantren Yatim dan Du’afa Al-Kasyaf. 

G. Langkah-Langkah penelitian 

1. Lokasi Penelitian 

Lokasi peneltian yang di lakukan oleh penulis yaitu di Pondok Pesantren 

Yatim dan Du’afa Al-Kasyaf Cipadung-Cibiru Kota Bandung. Adapun 

alasan memilih tepat penelitian di Pondok Pesantren Yatim dan Du’afa Al-

Kasyaf ini ialah : 

a) Tersedianya data yang akan dijadikan fokus penelitian 

b) Terdapat peramasalahan dalam penyesuaian diri remaja di Pondok 

Pesantren Yatim dan Du’afa Al-Kasyaf 

2. Paradgma dan Pendekatan 

Dalam penelitian kuantitatif, yang dilandasi pada suatu asumsi 

bahwa suatu gejala itu dapat diklasifikasikan, dan hubungan gejala bersifat 

kausal (sebab akibat), maka peneliti dapat melakukan penelitian dengan 

memfokuskan kepada beberapa variabel saja. Pola hubungan antara vaiabel 

yang akan diteliti tersebut selanjutnya disebut sebagai paradigma penelitian 

atau model penelitian. (Sugiyono P. D., 2010) 

Jadi paradigma penelitian dalam hal ini diartikan sebagai pola pikir yang 

menunjukan hubungan antara variabel yang akan diteliti yang sekaligus 

mencerminkan jenis dan jumlah rumusan masalah yang perlu dijawab 

melalui penelitian, teori yang digunakan untuk merumuskan hipotesis, jenis 



10 
 

 
 

dan jumlah hipotesis, dan teknis analisis statistic yang akan digunakan. 

Berdasarkan hal ini maka bentuk-bentuk paradigma atau model penelitian 

kuantitatif. Paradigma sederhana ini terdiri atas satu variabel independen 

dan dependen. Hal ini dapat digambarkan seperti gambar 1.2 berikut. 

 

  r 

 

Gambar 1.1 Paradigma Sederhana 

X = Bimbingan Pribadi-sosial   

Y = Penyesuaian diri remaja di panti asuhan 

3. Metode Penelitian 

Metode yang digunakan dalam penelitian ini yakni metode 

deskriptif dengan pendekatan Kuantitatif. Penelitian ini merupakan 

penelitian yang bertujuan untuk menganalisis menggambarkan serta 

menjelaskan fenomena yang ada. Penelitian ini menilai sifat dari kondisi-

kondisi yang tampak. Tujuan dalam penelitian ini dibatasi untuk 

menggambarkan karakteristik sesuatu sebagaimana adanya. 

4. Jenis Data dan Sumber Data 

a. Jenis Data 

Jenis data yang di kumpulkan oleh penulis yakni : 

1) Data mengenai Tugas pokok dan Fungsi (TUPOKSI) pembimbing 

di Pondok Pesantren Yatim dan Du’afa Al-Kasyaf. 

2) Data remaja di Pondok Pesantren Yatim dan Du’afa Al-Kasyaf. 

Y X 
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3)  Data hasil bimbingan pribadi sosial yang di lakukan di Pondok 

Pesantren Yatim dan Du’afa Al-Kasyaf. 

b. Sumber Data 

1) Sumber data Primer 

Sumber data primer yaitu pembimbing dan remaja di Pondok 

Pesantren Yatim dan Du’afa Al-Kasyaf Cipadung. 

2) Sumber data Sekunder 

Sumber data sekunder yaitu data yang di ambil dari bahan-bahan 

pustaka yang berupa buku-buku dokumen, hasil penelitian oranglain 

yang ada kaitannya dengan penelitian ini. 

c. Populasi dan Sampel 

 Populasi dalam penelitian ini berjumlah 70 remaja, dalam 

pengambilan sampel penulis menggunakan teknik sampling populasi 

dimana penentuan teknik sampling populasi ini mengacu pada pendapat 

yang di sampaikan oleh Arikunto (2008, hal. 116) yakni Penentuan 

Pengambilan sampel apabila kurang dari 100 lebih baik diambil semua 

hingga penelitiannya merupakan penelitian populasi. Jika jumlah 

subyeknya besar dapat diambil antara 10-15% atau 20-55% atau lebih 

tergantung kondisi dari subjek penelitian. Dengan demikian dalam 

penelitian ini peneliti mengambil sampel 70 remaja sesuai dengan 

jumlah poplasi remaja yang ada di Pondok Pesantren Yatim dan Du’afa 

Al-Kasyaf.  
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 Alasan mengambil teknik sampling populasi ini ialah untuk 

mengetahui kondisi keseluruhan remaja di Pondok Pesantren Yatim dan 

Du’afa Al-Kasyaf dan seberapa besar pengaruh bimbingan pribadi-

sosial yang dilaksanakan di Pondok Pesantren Yatim dan Du’afa Al-

Kasyaf terhadap penyesuaian diri remajanya. 

d. Teknik pengumpulan data 

 Pengumpulan data adalah suatu proses pengumpulan data primer 

dan sekunder dalam suatu penelitian. Pengumpulan data merupakan 

langkah yang amat penting, karena data yang di kumpulkan akan 

digunakan untuk pemecahan masalah yang sedang diteliti atau untuk 

menguji hipotesis yang telah di rumuskan. (Siregar, 2013:39) 

Metode pengumpulan data yang digunakan yaitu : 

1. Wawancara 

Dalam penelitian ini penulis mengumpulkan data dengan 

menggunakan jenis wawancara terstruktur dimana jenis wawancara 

terstruktur ini digunakan sebagai cara untuk memperoleh data 

dengan cara memberikan pertanyaan kepada narasumber. Tujuan 

menggunakan jenis wawancara terstruktur ini untuk mendapatkan 

suatu kejelasan mengenai fenomena yang ada di tempat penelitian. 

2. Observasi 

Dalam penelitian ini penulis menggunakan jenis observasi  

partisipasi, diamana dalam jenis observasi partisipasi ini penulis 
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terlibat aktif dalam objek yang di teliti untuk dapat mengamati serta 

meneliti objek yang akan di jadikan fokus penelitian.  

3. Kuisioner 

Dalam penelitian ini jenis angket digunakan yakni jenis 

kuisioner tertutup dimana dalam kuisioner tersebut telah disediakan 

alternatif jawaban untuk responden. Tujuan menggunakan angket 

tertutup ini ialah untuk mendapatkan data dan informasi yang tepat 

dari responden. 

e. Validitas dan reliabilitas 

Validitas atau kesahihan menunjukan sejauh mana suatu alat ukur 

mampu mengukur apa yang ingin di ukur (a valid measure if 

succsesfully measure the phenomenon). (Siregar, 2014, hal. 75) dalam 

penelitian ini peneliti menggunakan kuisioner dalam pengumpulan data 

penelitian, maka item-item dalam kuisioner tersebut yang akan di uji 

validitiasnya untuk mengukur apa yang akan menjadi tujuan penelitian. 

Sedangkan realibilitas yakni menunjukan konsistensi dan akurasi 

hasil pengukuran. Dimana konsep dari reliabilitias yakni sejauh mana 

hasil pengukuran dapat di percaya, artinya sejauhmana hasil pengukuran 

terbebas dari kekeliruan pengukuran (measurement error). 

Suatu instrument dikatakan valid apabila mampu mengukur apa 

yang akan diukur dan dapat mengungkapkan data dari variable yang 

diteliti secara tepat (Arikunto, 2007). Hasil r hitung jika bandingkan 
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dengan r tabel dimana df = n-2 sebagai sig 5%. Jika r tabel < r hitung 

maka dinyatakan valid (Arikunto, 2007). 

Uji validitas dilakukan dengan jumlah responden 70 orang, 

maka nilai r table dapat diperoleh melalui table r product moment 

pearson  dengan df = n-2, maka berlaku aturan kriteria uji : R hitung > 

R tabel.  

Langkah yang digunakan dalam SPSS adalah sebagai bertikut : 

1) Analyze > Scale > Reliability Analysis. 

2) Masukan p1, p2, p3, dst ke kotak item. 

3) Klik statistcs > Beri tanda √ pada Scale if item deleted 

4) Klik Continue 

5) Klik OK 

Reliabilitas adalah ketetapan suatu tes apabila diteskan kepada 

subyek yang sama. Untuk mengetahui ketetapan ini pada dasarnya 

dilihat dari kesejajarn hasil. Kriteria yang digunakan untuk mengetahui 

ketetapan suatu tes terdapat kriteria yang berada diluar tes (consistency 

external) dan yang ada pada tes itu sendiri (consistency internal).  

Uji reliabilitas bertujuan untuk menguji konsistensi pengukuran 

yang dilakukan dengan alat ukur bila dilakukan secara berulang. Uji 

reliabilitas menggunakan metode alpa cronbach. Jika koefisien alpa 

cronbach lebih besar dari 0,7 maka item pernyataan dinyatakan reliable 

(Arikunto, 2007). 
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f. Teknik analisis Data 

Analisis data yang dilakukan menggunakan teknik analisis 

deskriptif, yaitu data yang dihasilkan dari wawancara dengan 

Pembimbing dan Santri. Peneliti menggunakan pendekatan kuantitatif 

yaitu dengan cara memproses yang didapat dari hasil survey melalui 

kuisioner pada lembar kode, kemudian distribusi frekuensi disusun 

untuk tiap-tiap variabel penelitian dan merupakan bahan dasar untuk 

analis berikutnya. Dan dengan cara diolah kedalam skor frekuensi 

melalui proses sebagai berikut: 

1) Membuat kolom dengan skor item, skor tanggapan responden, dan 

total skor. 

2) Mencari yang diobservasi dengan cara sejumlah total dari setiap 

alternative jawaban. 

3) Mencari keseluruhan skor dengan menjumlahkan total dari setiap 

alternatif jawaban. 

4) Setiap soal mempunyai 5 alternatif jawaban yaitu : Sangat Setuju 

(SS), Setuju (S), Ragu-ragu (R), Tidak Setuju (TS), Sangat Tidak 

Setuju (SS). 

5) Untuk mencari persentase skor masing-masing jawaban 

menggunakan rumus: 
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Gambar 1.2 Skor Aktual 

 (Sugiono, 2010: 95) 

Skor aktual adalah jawaban seluruh responden atas 

kuesioner yang telah diajukan. Skor ideal adalah skor atau bobot 

tertinggi atau semua responden diasumsikan memilih jawaban skor 

tertinggi.  

Penjelasan bobot nilai skor aktual dapat dilihat pada tabel berikut: 

Tabel 1.1 

Bobot Nilai Skor Aktual 

No % Jumlah Skor Kriteria 

1 20.00% - 36.00% Tidak Baik 

2 36.01% - 52.00% Kurang Baik 

3 52.01% - 68.00% Cukup 

4 68.01% - 84.00% Baik 

5 84.01% - 100% Sangat Baik 

(Umi Narimawati, 2007:85) 

Setelah data terkumpul, langkah selanjutnya yaitu analisis data. 

Analisis data merupakan penyederhanaan data kedalam proses-proses yang 

lebih mudah dibaca dan diinterpretasikan melalui penyusunan kata-kata 

tertulis atau lisan dari orang-orang pelaku yang diamati (Arikunto, 2013). 

Dalam penelitian ini akan menggunakan alat bantu SPSS Versi 20 untuk 

% Skor Aktual ==
Skor Aktual

Skor Ideal
 X 100% 
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mempermudah dalam mengelola data berupa angka-angka yang diperoleh 

dari hasil kuisioner. Kemudian peneliti melakukan beberapa pengujian 

sebagai berikut: 

1) Uji Normalitas 

Uji normalitas digunakan untuk mengetahui normal atau 

tidaknya suatu data untuk mengetahui langkah-langkah yang digunakan 

selanjutnya. (Susetyo, 2012 : 189-190). Dalam uji normalitas ini peneliti 

menggunakan SPSS 20. Dapat dilihat dari kriteria Asmp Sign (1-tailed) 

atau Pvalue dan α, dengan α sebesar 5% atau 0,05, dengan kriteria jika 

Pvalue ≥ α maka data dinyatakan berdistribusi normal, sebaliknya jika 

Pvalue ≤ α maka data dinyatakan berdistribusi tidak normal. Adapun 

hipotesis yang diajukan pada uji normalitas sebagai berikut:  

H0  : Data berasal dari populasi yang berdistribusi normal. 

H1 : Data tidak berasal dari populasi yang berdistribusi  normal. 

Menurut kariadinata (2011: 59) jika tidak berdistrbusi normal 

maka dilanjutkan dengan tes median. 

2) Uji Korelasi 

Uji Korelasi yang digunakan adalah Uji korelasi Product Moment 

Pearson. Kegunaan korelasi product moment pearson adalah sebagai 

berikut : 

a) Untuk menyatakan ada atau tidaknya hubungan antara variabel X 

dan Y. 
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b) Untuk menyatakan besarnya sumbangan (pengaruh) variabel satu 

terhadap yang lainnya dinyatakan dengan persen.  

3) Uji Regresi Sederhana (Uji t) 

Regresi secara umum adalah sebuah alat statistik yang 

memberikan penjelasan tentang pola hubungan antara 2 variabel atau 

lebih. Dalam analisis regresi dikenal 2 jenis variabel yaitu variabel 

dependen yang dinotasikan dengan Y variabel independen yang 

dinotasikan dengan X. Tujuan dari analisis regresi adalah untuk 

mengestimasi parameter model yang menyatakan pengaruh hubungan 

antara variabel X dan variabel Y. Berikut langkah-langkah menguji 

regresi sederhana dengan SPSS versi 20: Analyze → Regression 

→linear. 

4) Koefisien determinasi 

Koefisien determinasi digunakan untuk mengetahui seberapa 

besar pengaruh variabel X (Bimbingan Pribadi Sosial) terhadap variabel 

Y (Penyesuaian Diri Remaja). Koefisien determinasi dihitung dengan 

menggunakan SPSS versi 20 menggunakan langkah-langkah: Klik 

Statistic → ceklis pada model Fit, R Square change, Part Partial 

Corelation → Continue. 

5) Uji Linearitas 

Uji linearitas bertujuan untuk mengetahui apakah dua variabel 

mempunyai hubungan yang linear atau tidak secara signifikan. Uji ini 

biasanya digunakan sebagai prasyarat dalam analisis korelasi atau 
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regresi linear. Pengujian pada SPSS dengan taraf signifikan 0,05. Dua 

variabel dikatakan mempunyai hubungan yang linear bila signifikansi 

(linearity) kurang dari 0,05. Adapun caranya yaitu: 

a) Analyze → Compare Means → Means. 

b) Klik Variabel Y ke kotak dependent list, klik Variabel X ke kotak 

independent list. 

c) Options, pada statistic First Layer → Klik Test for linearity → 

Continue. 

d) OK. 

 

 

 

 

 

 


